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CONTENT

> Adding Math Channels
> Creating Formulas

> Standard Operations
> Trigonometric
> Logical
> Measurement
> Miscellaneous
> Creation of Reference Curves in Time Domain
> Array channel support for formulas

> Creating Statistics
> Array channel support for statistics

> Creating Filters
> Offline Math
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ADD MATH CALCULATIONS TO THE MEASUREMENT SETUP

① To create
> Formulas
> FIR Filter
> Cepstrum/Quefrency
> Correlation
> Rosette calculations
> Frequency Measurement
> Constant Percentage Bandwidth (CPB)
> Order analysis modules
> Power Group
> Sound Level
> Modal Test
> Tape Sensor
> Resolver
> Matrix Sampler
Press the + button. Select the proper 
calculation and press Add

② Reference channels must be selected before 
creating
> Statistics
> FFT
> IIR Filter
> Percentile Measurement
> Swept sine analysis
> Psophometers
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CREATING A FORMULA

①
Press the + button, select Formula and 
press Add
Formula editor will open afterwards

② Formula Input field

③
Press the + button to add a channel to 
the input field or use drag-and-drop

④ Selection of math functions

⑤
Numeric pad with basic mathematic 
operations

⑥ Preview of the formula output

⑦
Enum label editor
Sets up text labels for specific values

①

②

③

④
⑤

⑥

⑦
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SIMPLE EXAMPLES
① Multiplication of 2 signals

② Mean average of 3 signals 

③ 2*sin(2*pi*1*time)

+chx/x*0 required to determine the 
correct time base

Channels can have different sample 
rates, thus OXYGEN needs one time 
reference in each formula

②

③

①
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MATHEMATICAL OPERATIONS – STANDARD OPERATIONS

① Standard operations

② Trigonometric operations

③ Logical operations

④ Measurement operations

⑤ Misc

②

①

Function Description Syntax
e Euler’s number e
π Constant Pi pi

min Minimum of two values min(x,y)
max Maximum of two values max(x,y)
abs Absolute value abs(value)
x^y Exponential function with arbitrary basis pow(x,y)
e^ Exponential function with basis e exp(x)
2^ Exponential function with basis 2 exp2(x)
ln Natural logarithm to basis e ln(x)

log Common logarithm to basis 10 log(x)

√ Square root sqrt(x)

∛ Cube root cbrt(x)

Tool tips pop up when 
the mouse remains on 
one operation
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MATHEMATICAL OPERATIONS – TRIGONOMETRIC
① Standard operations

② Trigonometric operations

③ Logical operations

④ Measurement operations

⑤ Misc

Function Description Syntax
sin Sine sin(x)

asin Arc sine asin(x)
sinh Hyperbolic sine sinh(x)

asinh Arc hyperbolic sine asinh(x)
cos Cosine cos(x)

acos Arc cosine acos(x)
cosh Hyperbolic cosine cosh(x)

acosh Arc hyperbolic cosine acosh(x)
tan Tangent tan(x)

atan Arc tangent atan(x)
tanh Hyperbolic tangent tanh(x)

atanh Arc hyperbolic tangent atanh(x)
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MATHEMATICAL OPERATIONS – LOGIC
① Standard operations

② Trigonometric operations

③ Logical operations

④ Measurement operations

⑤ Misc

Function Description Syntax

<
If ‘value1’ is less than ‘value2’, the result is 

1.0 else 0.0
value1 < value2

≤
If ‘value1’ is less than or equals ‘value2’, the 

result is 1.0 else 0.0
value1 <= value2

>
If ‘value1’ is greater than ‘value2’, the result 

is 1.0 else 0.0
value1 > value2

≥
If ‘value 1’ is greater than or equals ‘value 

2’, the result is 1.0 else 0.0
value1 >= value2

=
If ‘value 1’ equals ‘value 2’, the result is 1.0 
else 0.0 (Two NaNs do not compare equal

value1 == value2

≠
If ‘value 1’ is different than ‘value 2’, the 

result is 1.0 else 0.0
value1 != value2

and

Logic and:
value1 != 0.0 and value2 != 0.0 → 1.0
value1 = 0.0 and value2 != 0.0 → 0.0
value1 != 0.0 and value2 = 0.0 → 0.0
value1 = 0.0 and value2 = 0.0 → 0.0

value1 and value2

or

Logic or:
value1 != 0.0 or value2 != 0.0 → 1.0
value1 = 0.0 or value2 != 0.0 → 1.0
value1 != 0.0 or value2 = 0.0 → 1.0
value1 = 0.0 or value2 = 0.0 → 0.0

value1 or value2

not
Logic negation:

If value = 0.0, the result is 1.0, else 0.0
not value

if
If condition is true, the result is ‘true_val’, 

otherwise ‘false_val’
if(condition,true_val,false_val)

isnan If value is NaN, result is 1.0, 0.0 otherwise isnan(value)
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MATHEMATICAL OPERATIONS – MEASUREMENT
① Standard operations

② Trigonometric operations

③ Logical operations

④ Measurement operations

⑤ Misc

Function Description Syntax
ecnt1 Count number of edges on condition; condition is 

mandatory, rearm and reset parameter optional
ecnt(cond,rearm,reset)

hold2 Hold value at trigger condition; value and condition 
parameters are mandatory, init and rearm optional

hold(value,cond,init,rearm)

stopwatch3 Measure the timespan between two conditions in 
seconds; start and stop condition is both mandatory, 
reset is optional

stopwatch(start_cond,stop_c
ond, reset)

measdiff4 Measure the value difference of one channel 
between two conditions

measdiff(val,cond1,cond2)

period5 Measure the period duration in seconds between 
consecutive conditions with optional rearm 
condition

Edge(cond,rearm)

dutycycle6 Measure the dutycycle (from 0 to 1) between 
consecutive conditions with optional rearm 
condition

Dutycycle(cond,rearm)

edge7 Generate positive edge on cond with rearm 
condition

Edge(cond,rearm)

rmin8 Measure rolling overall minimum of a channel 
during a measurement with optional reset condition

rmin(value,reset)

rmax8 Measure rolling overall maximum of a channel 
during a measurement with optional reset condition

rmax(value,reset)

ravg8 Measure rolling overall average of a channel during 
a measurement with optional reset condition

ravg(value,reset)

rrms8 Measure rolling overall RMS of a channel during a 
measurement with optional reset condition

rrms(value,reset)

rsum8 Measure rolling overall sum of a channel during a 
measurement with optional reset condition

rsum(value,reset)

racrms8 Measure rolling overall ACRMS of a channel during a 
measurement with optional reset condition; Not 
included in the selection and must be typed 
manually 

racrms(value,reset)

rp2p8 Measure rolling overall Peak-to-Peak of a channel 
during a measurement with optional reset 
condition; Not included in the selection and must be 
typed manually 

Rp2p(value,reset)
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MATHEMATICAL OPERATIONS – MEASUREMENT
① Standard operations

② Trigonometric operations

③ Logical operations

④ Measurement operations

⑤ Misc
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MATHEMATICAL OPERATIONS – MISC
① Standard operations

② Trigonometric operations

③ Logical operations

④ Measurement operations

⑤ Misc
Function Description Syntax

time* Returns the elapsed time since 
acquisition (re)start in seconds

time

mtime* Returns the elapsed time since 
measurement star in secondst

mtime

scnt* Counts the number of samples since 
acquisition (re)start

scnt

sr* Returns the Sample Rate in Hz sr
mod Remainder of division x/y, sign of x mod(x,y)
noise Creates Noise signal in the range [-x…+x] noise(x)
atan2 Arc tangent of y/x using signs of 

arguments to determine the correct 
quadrant

atan2(y,x)

floor Rounds x towards minus infinity floor(x)
ceil Rounds x towards plus infinity ceil(x)

round Round to nearest integer round(x)
trunc Round x towards zero trunc(x)

* A channel to which the function refers must be specified, i.e. in the following manner: 
‘Ref_Ch’*0+time
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MATHEMATICAL OPERATIONS – MEASUREMENT TIME

① Measurement time function can be used 
to generate reference curves in time 
domain
Create a formula determining the 
measurement time

② Open the scaling options of this channel 
which are accessible in the Channel List

③ The table scaling can be used to define 
the boundary points of the reference 
curve

④ Can be displayed in a Recorder to check 
if the channel(s) exceeds the limit or is 
within the limit

②

③

④

①
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MATHEMATICAL OPERATIONS – MEASUREMENT TIME

① Measurement time can be easily 
displayed on the screen as it can be 
dragged and dropped to a Text 
instrument directly from its properties

①
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ARRAY MATH FORMULAS

①②

Array channels such as Harmonics, FFT 
or CPB channels can be used in Formulas

① Basic math operations for arrays with 
same dimensions
supported: + - * /

② Operations (+ - * /) with
constants supported

Output is always a new
array channel with same
dimensions
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ARRAY MATH FORMULAS

⑤

③

④

Possibility to use

③ Standard operators 

④ Trigonometric operators

⑤ Logic operators 
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ARRAY MATH FORMULAS 

> Exctraction of adjacent elements into a 
new array in C++ / Python syntax (⑥)

> First element of array is always 0!

> Optional step size definition (⑦)

> Creation of arrays with constants (⑧)

1st Inclusive Last Exclusive

⑥

⑧⑦
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CREATING STATISTICS
① Select one or several channels by 

checking their check boxes and press the 
+ button

② Select Statistics, choose the proper 
calculations (several can be selected) 
and the desired time window

③ Press Add afterwards to create these 
channels

④ A separate output channel for each 
reference channel and calculation is 
created 

⑤ Changes can still be applied by entering 
the settings of the desired channel via 
the Gear button

⑥ Select if calculation (starting at 
acquisition start) shall be reset at 
recording start

④

⑥

⑤

②

③

①
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CALCULATION REMARKS

𝐴𝑉𝐺 =
1

𝑁
෍

𝑖=1

𝑁

𝑆𝑖𝑔𝑛𝑎𝑙𝐿𝑒𝑣𝑒𝑙𝑖
𝐴𝐶𝑅𝑀𝑆 =

1

𝑁
෍

𝑖=1

𝑁

𝑆𝑖𝑔𝑛𝑎𝑙𝐿𝑒𝑣𝑒𝑙𝑖 − 𝐴𝑉𝐺 2

𝑀𝐴𝑋 = 𝑀𝐴𝑋 𝑆𝑖𝑔𝑛𝑎𝑙𝐿𝑒𝑣𝑒𝑙𝑖

𝑀𝐼𝑁 = 𝑀𝐼𝑁 𝑆𝑖𝑔𝑛𝑎𝑙𝐿𝑒𝑣𝑒𝑙𝑖

i = 1…N
N = Sample Rate of Input Channel * Window Size

𝑅𝑀𝑆 =
1

𝑁
෍

𝑖=1

𝑁

𝑆𝑖𝑔𝑛𝑎𝑙𝐿𝑒𝑣𝑒𝑙𝑖
2 = 𝐴𝑉𝐺2 + 𝐴𝐶𝑅𝑀𝑆2

Calculation remarks can be seen on the right 
hand side

If rolling (overall) statistics, i.e. maximum 
value during the measurement are required, 
refer to the functions in the table below 
which are available in the formula setup

These formulas are reset at measurement 
start

Additionally, user defined reset events can be 
defined, i.e. ch1 decreases 0

racrms and rp2p are not available in the menu 
but can be typed into the formula editor 
manually

rmin Measure rolling overall minimum of a channel during a 
measurement with optional reset condition

rmin(value,reset)

rmax Measure rolling overall maximum of a channel during a 
measurement with optional reset condition

rmax(value,reset)

ravg Measure rolling overall average of a channel during a 
measurement with optional reset condition

ravg(value,reset)

rrms Measure rolling overall RMS of a channel during a measurement 
with optional reset condition

rrms(value,reset)

rsum Measure rolling overall sum of a channel during a measurement 
with optional reset condition

rsum(value,reset)

racrms Measure rolling overall ACRMS of a channel during a 
measurement with optional reset condition; Not included in the 
selection and must be typed manually 

racrms(value,reset)

rp2p Measure rolling overall Peak-to-Peak of a channel during a 
measurement with optional reset condition; Not included in the 
selection and must be typed manually 

Rp2p(value,reset)
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FURTHER STATISTICS (AVAILABLE SINCE R6.1)
> Peak-Peak: Calculates the peak-peak 

value

> SUM: Calculates the sum

> MIN Time: Determines the time, where 
the minimum of the signal was reached

> MAX Time: Determines the time, where 
the maximum of the signal was reached

> COUNT: Counts the number of samples 
in one measurement block

> Variance: Calculates the variance
(squared ACRMS value)

> Coefficient of Variance (CV): Calculates 
the Coefficient of variance (division of
ACRMS and AVG)

> Peak: Calculates the peak value

> Crest: Calculates the crest factor
(division of the MAX and RMS value)
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OVERALPPING STATISTICS (AVAILABLE SINCE R6.1)

> Overlapping Window
size

> 0 % (behaviour until now)

> 50 %

> 75 %

> 80 %

> 90 %

> 95 %
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OVERALL STATISTICS (AVAILABLE SINCE R6.1)

> Outputs one overall
value from recording
start to recording end

→ Reset on measurement
start

> No time history
included
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TRIGGERED STATISTICS (AVAILABLE SINCE R6.2)

> Begins statistics
calculation on trigger

> Trigger event can be
on rising or falling
edge

> Stop modes:

• Retrigger

• Duration

• Stop trigger
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RUNNING STATISTICS (AVAILABLE SINCE R6.2)

> Inherits sample rate of
input channel

> Looks back the
window size on each
new sample

> Calculates statistic for
this „look back“-
window

Example:

Looks back 1s and 
calculates average

Input signal: f(t) = t 
Sampled at 1kHz

Running stat: AVG 
Window size: 1s
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ARRAY MATH STATISTICS

> Arrays can be assigned
to Statistics

> Output is always a new
array channel with same
dimensions
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CREATING IIR-FILTERS
① Select one or several channels to be 

filtered by checking their check boxes 
and press the + button

② Select Filters, choose the proper one and 
its settings

③ Press Add afterwards to create these 
channels

④ A separate output channel for each 
filtered reference channel is created 

⑤ Changes can still be applied by entering 
the settings of the desired channel via 
the Gear button

①

②

③

④

⑤
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CREATING FIR-FILTERS
① Select one or several channels to be 

filtered by checking their check boxes 
and press the + button

② Select Filters, choose the proper one and 
its settings

③ Press Add afterwards to create these 
channels

④ A separate output channel for each 
filtered reference channel is created 

⑤ Changes can still be applied by entering 
the settings of the desired channel via 
the Gear button

⑥ Additional channels can be added or 
deselected

①

②

③

④
⑤ ⑥
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FILTER SETTINGS
Available Filters:

> Lowpass

> Highpass

> Bandpass

> Bandstop

> Integrator (Single or Double)

> Differentiator (Single or Double)

> Lowpass & Highpass:

> 𝑓𝐶 𝑚𝑎𝑥 =
𝑓𝑆

2
− 50 𝐻𝑧

> Bessel or Butterworth characteristic

> 2nd, 4th, 6th, 8th or 10th order

> Bandpass & Bandstop

> 𝑓𝑙 = 0 … 𝑓ℎ − 1 𝐻𝑧

> 𝑓ℎ = 𝑓𝑙 + 1 𝐻𝑧 …
𝑓𝑆

2
− 50 𝐻𝑧

> Bessel or Butterworth characteristic

> 2nd, 4th, 6th, 8th or 10th order

> Integrator & Differentiator

> Single or Double Integration/Differentiation

> Enable low (Integrator) or high (Differentiator) frequency component filtering

> 𝑓𝐶 𝑚𝑎𝑥 =
𝑓𝑆

2
− 50 𝐻𝑧

> Bessel or Butterworth characteristic

> 2nd, 4th, 6th, 8th or 10th order

> Why filter frequency components during Integration / Differentation or not?

> → Integration of a velocity:

> With filtering enabled (no DC components), this calculation determines only the 

distance travelled from one data sample to the next one

> With filtering disabled (DC components included), this calculation determines the entire 

travelled distance as the determined distance from one data sample to the next is 

summed up 
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Remarks:
> Possibility to edit settings of software channels in *.dmd-files. Function must be activated 

once after opening *.dmd-file (④) 

> All existing channels and calculations created with + button can be edited if source 
channels are stored

> It is also possible to edit the settings of hardware channels, but only the name and the 
unit.

> Please keep in mind that the results of an offline calculated channel can differ from an 
online calculated channel, i.e. filters as they are oscillating at the beginning 

OFFLINE MATH – ADDING CALCULATIONS TO THE DATA FILE

① Basic and Advanced Math can be created 
offline

② Offline created channels are marked with 
a green Stored button

③ Any changes to a data file can be stored 
with the Store button ②①

③

④
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